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1. Important

Ce guide électronique de I'utilisateur est
congu pour toutes les personnes qui utilisent
le moniteur de Philips. Prenez le temps de lire
ce Manuel d'utilisation avant d'utiliser votre
moniteur: Il contient des informations et des
notes importantes au sujet de I'utilisation de
votre moniteur.

La garantie Philips s'applique a la condition que
le produit soit manipulé correctement pour
son utilisation prévue et conformément aux
instructions d'utilisation, et sur présentation

de la facture d'origine ou du ticket de caisse
d'origine, indiquant la date de I'achat, le nom du
revendeur ainsi que le modéle et le numéro de
production du produit.

1.1 Précautions de sécurité et
d'entretien

) Avertissements

Lutilisation de touches de réglages, d'ajustements
ou de procédures différentes de celles qui sont
décrites dans ce manuel pourrait présenter un
risque de choc électrique, d'électrocution et/ou
mécanique.

Lorsque vous connectez et utilisez le moniteur
de votre ordinateur, lisez et respectez les
consignes suivantes :

Utilisation

* Veulillez protéger le moniteur de la lumiere
directe du soleil, des forts éclairages et
ne I'utilisez pas a proximité de sources
de chaleur. L'exposition prolongée a
ces types d'environnement peut causer
des dommages au moniteur et une
décoloration.

+  Eloignez tout objet pouvant tomber dans
les orifices de ventilation ou empécher le
refroidissement correct des composants
électroniques du moniteur.

*  N'obstruez pas les orifices de ventilation
du boftier.

Lors de la mise en place du moniteur,
veillez a ce que la fiche d'alimentation et la
prise soient facilement accessibles.

Si vous mettez le moniteur hors tension en
débranchant le cable secteur ou le cable
d'alimentation CC, attendez 6 secondes
avant de rebrancher ces cables.

Utilisez toujours le cordon secteur fourni
par Philips. Si le cordon secteur est
manquant, veuillez contacter votre centre
de service local. (Reportez-vous au chapitre
Centre d'information a la clientele.)

Ne soumettez pas le moniteur a de fortes
vibrations ou a des impacts violents lorsque
vous ['utilisez.

Ne pas heurter ni laisser tomber le
moniteur pendant ['utilisation ou le
transport.

Entretien

Afin de protéger votre moniteur contre des
dommages, n'appuyez pas trop fortement
sur I'écran LCD. Lorsque vous déplacez le
moniteur; saisissez-le par son cadre pour le
soulever ; ne mettez pas vos mains ni vos
doigts sur I'écran LCD pour le soulever.

Débranchez le moniteur si vous envisagez
de ne pas l'utiliser pendant un certain
temps.

Débranchez le moniteur si vous voulez le
nettoyer. Pour ce faire, utilisez un chiffon
légerement humide.Vous pouvez aussi vous
servir d'un chiffon sec, pour autant que

le moniteur soit hors tension. Par contre,
n'utilisez jamais de solvants organiques,

tels que l'alcool ou des liquides a base
d'ammoniaque, pour nettoyer le moniteur.

Afin d'éviter tout risque d'électrocution ou
d'endommagement permanent a |'appareil,
n'exposez pas le moniteur a la poussiére ni
a la pluie.

Ne le mettez pas non plus en contact
avec de |'eau ni avec un environnement
excessivement humide.

Si votre moniteur est mouillé par de 'eau,
essuyez-le aussi rapidement que possible a



I'aide d'un chiffon sec. Si un corps étranger
ou de I'eau pénétrent dans le moniteur,
mettez-le immédiatement hors tension

et débranchez le cordon secteur. Retirez
ensuite le corps étranger ou épongez

I'eau et envoyez le moniteur au centre de
maintenance.

* Ne pas stocker ni utiliser le moniteur dans
des endroits tels qu'il risque d'étre exposé
a de la chaleur, a la lumiere directe du soleil
ou a un froid extréme.

* Afin d'assurer les performances optimales
de votre moniteur et |'utiliser pendant
plus longtemps, il doit se trouver dans
un endroit compris dans les plages de
température et d'humidité suivantes :

* Température : 0-40°C 32-95°F
* Humidité : 20-80% HR

*  IMPORTANT : Activez systématiquement
un programme économiseur d'écran en
mouvement lorsque votre écran n'est pas
sollicité. Activez systématiquement une
application de rafraichissement périodique
de votre moniteur pour afficher un contenu
statique fixe. L'affichage sans interruption
d'image statique ou immobile sur une
longue période peut engendrer une «
rémanence a l'extinction », également
appelée « image résiduelle » ou « image
fantdbme » sur votre écran.

Ces images « rémanentes », « en
surimpression » ou « fantdmes » sont un
phénomeéne bien connu de la technologie
des panneaux LCD. Dans la plupart des
cas, cette « rémanence a l'extinction », ou
« image résiduelle » ou « image fantdbme
» disparait progressivement une fois
I'alimentation éteinte.

) Avertissement

Les symptomes de « brllure », d'« image
résiduelle » ou d'« image fantdme » ne
disparaftront pas et ne pourront pas étre
réparés si vous n'utilisez pas un économiseur
d'écran ou une application de rafraichissement
périodique de I'écran. Ce dommage n'est pas
couvert par votre garantie.

Service aprés-vente :

* Le boftier peut uniquement étre ouvert par
un technicien qualifié.

* Sivous avez besoin de documents en
vue d'une réparation, veuillez prendre
contact avec votre centre de service local.
(Reportez-vous au chapitre « Centre
d'information a la clientéle. »)

*  Pour plus d'informations sur le transport,
veuillez vous référer a la section
« Caractéristiques techniques ».

* Ne laissez pas votre moniteur dans une
voiture ni dans un coffre de voiture a la
lumiere directe du soleil.

& Remarque

Adressez-vous a un technicien si le moniteur ne
fonctionne pas normalement ou si vous n'étes
pas sUr(e) de la procédure a suivre apres avoir
lu les instructions du mode d'emploi.



1.2 Notations

Les sous-parties suivantes décrivent les
différentes conventions de notation utilisées
dans ce document.

Notes, mises en garde et avertissements

Tout au long de ce guide, des blocs de texte
pourront étre accompagnés d'une icdne et
imprimés en caractéres gras ou en italiques.
Ces blocs contiennent des notes, des mises en
garde ou des avertissements. Ils sont utilisés de
la facon suivante:

© Remarque

Cette icéne indique I'existence d'informations
et de conseils importants vous aidant a mieux
utiliser votre ordinateun.

@ Mise en garde

Cette icone indique I'existence d'informations
vous expliguant comment éviter
I'endommagement potentiel de votre matériel
ou la perte de données.

D) Avertissement

Cette icone indique qu'il existe un risque de
blessures et vous explique comment éviter le
probléme.

Il se peut que des avertissements apparaissent
sous des formats différents et ne soient pas
accompagnés d'icdnes. Dans ces cas-Ia, la
présentation spécifique de l'avertissement

est dictée par les autorités chargées des
réglementations.

1.3 Mise au rebut du produit et des
matériaux d’emballage

Déchet d’équipement électrique et
électronique - DEEE

Cette Marque sur le produit ou sur 'emballage
illustre que, sous la Directive Européenne
2002/96/EC gouvernant |'utilisation des
équipements électriques et électroniques,

ce produit peut ne pas étre jeté avec les
ordures ménageres.Vous étes responsable

de I'élimination de cet équipement a travers
une collection aux déchets d'équipements
électriques et électroniques désignés. Afin de
déterminer les emplacements de telles ordures
électriques et électroniques, veuillez contacter
votre représentant du gouvernement local pour
connaitre l'organisation de décharge d'ordure
dont dépend votre foyer ou le magasin ot vous
avez acheté le produit.

Votre nouveau moniteur contient des
matériaux recyclables et réutilisables. Des
entreprises spécialisées peuvent recycler

votre produit pour augmenter la quantité de
matériels réutilisables et minimiser la quantité a
étre jetée.

Tous les matériaux d'emballage superflus

ont été enlevés. Nous avons essayé de notre
mieux de faciliter la séparation des matériaux
d'emballage en des matériaux basiques.

Veuillez consulter votre réglementation locale
relative a la mise au rebut de votre ancien
moniteur et des matériaux d'emballage auprés
de votre revendeur local.

Informations relative a la reprise/recyclage
destinées aux

Philips établit des objectifs viables d'un point de



vue technique et économie, visant a optimiser
les performances environnementales du produit,
du service et des activités de |'organisation.

Concernant le planning, la conception et les
étapes de production, Philips se concentre
sur une fabrication de produits facilement
recyclables. Chez Philips, la gestion de la fin de
vie inclut I'implication aux initiatives nationales
de reprise et aux programmes de recyclage,
lorsque cela est possible, idéalement en
coopération avec la concurrence, en recyclant
tous les matériaux (produits et matériaux
d'emballage correspondants), conformément a
I'ensemble des lois sur I'environnement et au
programme de reprise de |'entreprise.

Votre produit est fabriqué avec des matériaux
et des composants de haute qualité, qui peuvent
&tre recyclés et réutilisés.

Pour en savoir plus sur notre programme de
recyclage, visitez le site

http://www.philips.com/sites/philipsglobal/
about/sustainability/ourenvironment/
productrecyclingservices.page



2. Installation du moniteur

2.1 Installation

El Contenu de la boite

+
QSuiEart
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————————

DVI (Optionnel)

E1 Installer le socle

1. Placez le moniteur, face vers le bas, sur une
surface douce. Faites attention de ne pas
rayer ou endommager |'écran.

2. Enclenchez la base dans la zone de
montage VESA.

3. Tenez le socle avec vos deux mains.

(1) Attachez gentiment le socle a la
colonne jusqu'a ce que les trois attaches
rentrent dans les trous de position.

(2) Utilisez vos doigts pour serrer la
vis située en bas du socle, et fixez
fermement le socle a la colonne.




El Connexion a votre PC
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@ Entrée d'alimentation CA
© Entrée DV

© Entrée VGA

© Verrou antivol Kensington
© Entrée Audio

Connexion a un PC

1.

Connectez le cordon d'alimentation a
I'arriere du moniteur fermement.

Mettez votre ordinateur hors tension et
débranchez son cable d'alimentation.

Connectez le cable de signal du moniteur
au connecteur vidéo situé a l'arriere de
votre ordinateur.

Insérez les cables d'alimentation de votre
ordinateur et du moniteur dans une prise
secteur.

Mettez votre ordinateur et le moniteur
sous tension. Si le moniteur affiche une
image, cela signifie que I'installation est
terminée.

2.2 Utilisation du moniteur

El Descriptions des boutons de contrdle

-
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Allume et éteint (MARCHE

@ O |et ARRET) l'alimentation du
moniteur.
Ouvre le menu OSD.
0 S/0K Confirme le réglage de I'OSD.
O | AV Auste le menu OSD.
(4] Q- |Ajuste le niveau de luminosité.
(5) I(] Réglez le volume du moniteur.
Retourne au niveau précédent
0 < P

du menu OSD.

touche de raccourci Smartlmage.
Vous pouvez choisir entre

six modes différents : Office
o @ (Bureau), Photo, Movie (Film),
Game (Jeux), Economy

(Economie) et Off (Arrét).




E1 Description de I'affichage sur écran

Qu’est-ce que Affichage a I'écran (OSD)?

La fonction d'affichage des menus a I'écran
(OSD) est présente avec tous les moniteurs
LCD de Philips. Elle permet a I'utilisateur

final d'effectuer des réglages d'écran ou de
sélectionner directement les fonctions du
moniteur par le biais d'une fenétre d'instructions
apparaissant a |'écran. Une interface conviviale,
semblable a celle reproduite ci-apres, apparait :

Language

v

Instructions simples et basiques sur les
touches de controle

Dans le menu OSD ci-dessus, I'utilisateur peut
appuyer sur les boutons ¥ A situées sur le
panneau frontal du moniteur pour déplacer le
curseur, et sur OK pour confirmer un choix ou
une modification.

Le menu OSD

Vous trouverez ci-dessous une vue d'ensemble
de la structure de I'affichage sur écran.Vous
pourrez par la suite I'utiliser comme référence
lorsque vous voudrez plus tard revenir aux
différents réglages.

Main menu

— Input [

C
x

— Audio

— Color

— Language .

— OSD Settings —

—— Setup

Sub menu

VGA

DVI

Picture Format —
Brightness —
Contrast —
SmartContrast —
Gamma —_
Volume —
Mute —
Color Temperature ~ —
sRGB

User Define

English, German, Spanish,

Wide Screen, 4:3
0~100

0~100

Off, On
18,20,22,24,26
0~100

Off, On

5000K, 6500K, 7500K,
8200K, 9300K, 11500K

Red: 0~100
Green: 0~100

Blue: 0~100

Greek, French, ltalian,

Hungarian, Dutch, Portuguese, Portugués do Brazil,
Russian, Polish, Swedish, Finnish, Tirkce, Czech,
Ukrainian, S. Chinese, T.Chinese, Japanese, Korean

Horizontal —
Vertical —
Transparency —

OSD Time Out —

Auto

H.Position —
V.Position —
Phase —
Clock —
Resolution Notification —
Reset —

Information

0~100
0~100
Off, 1,2,3,4

5s, 10s, 20s, 30s, 60s

0~100
0~100
0~100
0~100
On, Off

Yes, No



El Avis de résolution

Ce moniteur a été congu pour fonctionner de
maniere optimale a sa résolution native, qui est
1600%900 @ 60 Hz. Quand le moniteur est
allumé a une autre résolution, le message d'alerte
suivant s'affiche a I'écran : Use 1600900 @

60 Hz for best results (Utilisez la résolution
1600%900 @ 60 Hz. pour des résultats
optimaux).

L'affichage du message d'alerte de résolution
native peut étre désactivé a partir de
Configuration dans le menu d'affichage a I'écran
(OSD).

B Fonction physique

Inclinaison

Rotation

Réglage de la hauteur

Faites pivoter




2.3 Enlever I'ensemble du socle pour

un montage VESA

Avant de commencer a enlever le socle du
moniteur, suivez les instructions suivantes
pour réduire le risque de blessure et/ou de
dommage.

1.

2.

Placez le moniteur, face vers le bas, sur une
surface douce. Faites attention de ne pas
rayer ou endommager I'écran.

Utilisez un tournevis plat pour enlever les
quatres vis mylar du bord du couvercle.

3.

Enlevez les vis du bord du couvercle.

© Remarque
Ce moniteur utilise une interface de montage
conforme a VESA de 100mm x 100mm.

7 3
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3. Optimisation de I'image

3.1 Smartlmage

E De quoi s'agit-il?

Smartimage propose des préréglages qui vous
permettent d'optimiser |'affichage de différents
types de contenu en ajustant dynamiquement la
luminosité, le contraste, la couleur et la netteté
en temps réel. Qu'il s'agisse de travaux sur

des applications de texte, d'affichage d'images
ou de visualisation d'un clip vidéo, Philips
Smartimage vous propose un moniteur avec
des performances optimisées.

E1 Pourquoi en ai-je besoin?

Vous attendez de votre moniteur un affichage
optimisé de tous vos types favoris de contenu.
Le logiciel Smartimage ajuste dynamiquement
la luminosité, le contraste, la couleur et la
netteté en temps réel pour une expérience de
visionnage améliorée avec votre moniteur.

E Comment ¢a marche?

Smartlmage est une technologie Philips
exclusive et de pointe. Elle analyse le contenu
affiché sur votre écran. En se basant sur

un scénario choisi, Smartlmage optimise
dynamiquement le contraste, la saturation des
couleurs et la netteté des images pour des
performances d'affichage ultimes, le tout en

temps réel par la simple pression sur un bouton.

Bl Comment activer Smartlmage ?

10

1. Appuyez sur e» pour lancer Smartlmage
sur l'affichage a I'écran.

2. Appuyez sans arréter sur ¥ A pour
basculer entre Office (Bureau), Photo
(Photo), Movie (Film), Game (Jeux),
Economy (Economie) et Off (Arrét).

3. L'affichage Smartlmage sur I'écran reste
affiché pendant 5 secondes, ou vous
pouvez également appuyer sur "OK" pour
confirmer.

4. Une fois Smartlmage activé, le schéma
sRVB est automatiquement désactivé. Pour
utiliser le modéle sRVB, il faut désactiver
Smartlmage en utilisant le bouton ED sur
le panneau avant de votre moniteur.

Vous pouvez choisir entre six modes différents :

Office (Bureau), Photo, Movie (Film), Game

(Jeux), Economy (Economie) et Off (Arrét).

Photo
Movie

Game

Economy

»  Office (Bureau) : Optimise le texte et
adoucit la luminosité pour augmenter la
lisibilité et réduire la fatigue oculaire. Ce
mode optimise la lisibilité et la productivité
de facon significative lorsque vous travaillez
avec des feuilles de calcul, des fichiers PDF,
des documents numérisés et d'autres
applications générales de bureau.

*  Photo : Ce profil associe la saturation
des couleurs, le contraste dynamique
et |'optimisation de la netteté pour un
affichage de photos et d'autres images
incroyablement clair avec des couleurs
vives - le tout sans effet parasite et sans
couleurs estompées.



*  Movie (Film) : La luminance accentuée,
la saturation profonde des couleurs, le
contraste dynamique et la netteté précise
permettent d'obtenir un affichage de
chaque détail dans les zones sombres de
vos clips vidéo, sans décoloration dans les
zones plus lumineuses, tout en maintenant
des valeurs dynamiques naturelles pour un
affichage vidéo optimal.

*  Game (Jeux) : Activez le circuit ‘overdrive’
pour obtenir un meilleur temps de
réponse, moins de flou sur les bords avec
des images qui changent rapidement sur
I'écran, un meilleur taux de contraste pour
les scénes claires ou foncées ; ce profil est
idéal pour les jeux.

+  Economy (Economie) : Dans ce profil,
le réglage de la luminosité et du
contraste ainsi que la rectification fine du
rétroéclairage permettent d'obtenir un
affichage correct pour les applications
quotidiennes de bureau, tout en diminuant
la consommation électrique.

»  Off (Désactivé) : Pas d'optimisation par
Smartimage.

3.2 SmartContrast

El De quoi s'agit-il?

Cette technologie unique analyse de fagon
dynamique le contenu a I'écran, et optimise
automatiquement le contraste du moniteur
pour une clarté visuelle et un plaisir visuel
maximum. Le rétroéclairage est ainsi augmenté
pour des images plus claires, plus précises et
plus lumineuses, ou diminué pour un affichage
clair des images sur fond sombre.

E1 Pourquoi en ai-je besoin?

Vous attendez une clarté visuelle optimale
et un confort visuel, quel que soit le type de
contenu a I'écran. SmartConstrast contréle
dynamiquement le contraste et ajuste le
rétroéclairage pour des images ou des
écrans de jeu et de vidéo claires, précises et
lumineuses, et pour du texte de bureautique

lisible. En réduisant la consommation électrique
de votre moniteur, vous réalisez des économies
énergétiques et prolongez la durée de vie de
votre écran.

E Comment ¢a marche?

Lorsque vous activez SmartContrast, ce dernier
va analyser le contenu affiché en temps réel

et ajuster les couleurs et controéler l'intensité

du rétroéclairage. Cette fonction permet
d'optimiser dynamiquement le contraste

pour plus de plaisir dans votre divertissement,
visionnage de clips vidéo ou jeux.

3.3 Philips SmartControl Premium

Le nouveau logiciel SmartControl Premium de
Philips vous permet de contrdler votre moniteur
a l'aide d'une interface graphique facile a utiliser.
C'en est fini des réglages compliqués, ce logiciel
pratique vous aide a ajuster la résolution, a

faire |'étalonnage des couleurs, les réglages de
I'horloge/de la phase, le réglage du point blanc
RGB, etc.

Grace aux dernieres technologies dans
I'algorithme principal, offrant un traitement et
un temps de réponse plus rapides, ce logiciel
compatible avec Windows 7 est basé sur des
icones avec une interface trés conviviale pour
vous aider a bien utiliser vos moniteurs de
Philips.

El |Installation

*  Suivez les instructions pour l'installation.

* Vous pouvez le lancer une fois I'installation
terminée.

» Sivous voulez lancer le logiciel
ultérieurement, vous pourrez alors cliquer
sur le raccourci du bureau ou de la barre
d'outils.



PHILIPS

wwow philps comiwelcome
Recured oot Monitor driver and software installation
Spen resremens:

+ PC ruming Windows 7, Vs, X7, 200058

Philps SmareControl

e

1.5

port Windows 7, Visa, .

3 P Marsor g and Py upport

Premier lancement — Assistant

* La premiere fois apres I'installation de
SmartControl Premium, I'assistant est
automatiquement lancé.

* L'assistant va vous aider a ajuster les
performances de votre moniteur, étape
aprés étape.

* Rendez-vous dans le menu Plug-in
(Branchement) pour lancer I'assistant
ultérieurement.

* Vous pouvez ajuster davantage d'options

sans |'assistant depuis le panneau Standard.

[] smartControl Premuum 2%
SmartControl Premium PHILIPS
Wizard
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Adiust Proferences

Audo

Cobor Auto Piot
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Eco Power Weard
e
2
Presets
[
Options Theft Deterrence
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\, SmonDesktop
frey Start wizard

B3 Lancement depuis le panneau Standard :

Menu Réglage

* Le menu Adjust (Réglage) vous permet
de régler les paramétres Brightness
(Luminosité), Contrast (Contraste), et
Resolution (Résolution).

* Suivez les instructions
réglages.

pour effectuer les

* L'invite Cancel (Annuler) vous permet

d'annuler I'installation.

] smarconto e

SmartControl Premium

1- X

PHILIPS

Brightness

rightness for

]

Adjust

e

Color

Bghtness

L

Contrast
Eco Power

Resoton

g

Optons

4

—

Adjust
Color )
Bness
s o o &
\g undo Reset
oovons
s\
Help.
et 7x
SmartControl Premium PHILIPS
Conlrast

Adjust U Contrast (use Ure

1
(3

Undo. Reset

12




@ srarConwotPrerion @x

Premium

SmartControl PHILIPS
Resolution

Towms sl B R Bl e
iy by it lhsinon
B e e
resolution.

T ———
o s

T Enable Resalition Notfer
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Menu Color (Couleur)

Le menu Color (Couleur) vous permet
de régler les parametres RGB (RVB),
Black Level (Niveau noir), White Point
(Point blanc), Display Gamma (Gamma
d'affichage), Calibration (Calibrage),
Smartimage, et SmartKolor.

Suivez les instructions pour effectuer les
réglages.

Référez-vous au tableau ci-dessous pour les
éléments du sous-menu selon votre choix.

Exemple pour Color Calibration
(I'étalonnage des couleurs).
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Display Gamma

Gamma is 2 companent of the pixel brightness ina
. A lower Gamma value produces briahter pxels

and 2 higher Gamma value produces darker pixct. The

default value for Gamma & 2.2.

To adjust Garrene, Smastimage must be set Lo OfT

Cick the Smartimage Off hutton before adjusting

Gamma.
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Calibration

Your dsplay nesds Lo be propery calibrated in order
or o prodiice the widest range of colors accurately.
Calibration should ke piace as the st tuning
ste n the process. Remember to recalbrate any tme
you make indiidual adjustments to i

. Fnaly, press Start 1o begn the calibration

¥ Enable cobr calbration

Colo softwara designed in colaboration with Joseph
Holmes.

Protacted by U.S. Patent No. 6,686,053

Show Me start

Quick View

« Show Me » lance le tutoriel d'aide a
I'étalonnage des couleurs.

Start (Démarrer) - lance la séquence
d'étalonnage des couleurs en 6 étapes.

Quick View (Visualisation rapide) charge les
images précédente/suivante.

Pour retourner au panneau d'accueil Color
(Couleur), cliquez sur le bouton Cancel
(Annuler).

Enable color calibration (Active I'étalonnage
des couleurs) - activé par défaut. Si la case
n'est pas cochée, il n'y a pas d'étalonnage
des couleurs, les boutons Démarrer et
Visualisation rapide sont grisés.

Les informations relatives au brevet doivent
figurer sur I'écran d'étalonnage.

Ecran de premier étalonnage des couleurs
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Le bouton Previous (précédent) est
désactivé jusqu'au deuxiéme écran de
couleur.

Next (Suivant) permet d'accéder a la cible
suivante (6 cibles).

Allez finalement dans le panneau File >
Presets (Fichier > Préréglages).
Cancel (Annuler) ferme l'interface

utilisateur et retourne a la page Plug-in
(Branchement).



Smartlmage

Permet a I'utilisateur de modifier les réglages
pour un meilleur affichage selon le contenu.

Lorsque le mode Entertainment
(Divertissement) est activé, SmartContrast et
SmartResponse sont également activés.
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Menu Options

Options>Preferences (Préférences) - n'est
disponible que lorsque vous choisissez
Preferences (Préférences) dans le menu
déroulant Options. Sur un écran non pris en
charge, mais compatible DDC/CI, seuls les
onglets Help (Aide) et Options sont disponibles.

@ St P e
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Preferences

\g Auomu

Color. Auto Pivot

-
\! e

coPower —
‘o
2

Presets

SmartContrast
€ On: SmartContrast
© Off: Economy

Options “Theft Deterrence

SmartDesktop
Power LED Button Brightness 3

Hep

+ Affiche les réglages préférés actuels.

* Cochez la case pour activer la fonction. La
case a cocher est une touche a bascule.

* Enable Context Menu (Activer le menu
contextuel) sur le bureau est coché
(activé) par défaut. Enable Context Menu
(Activer le menu contextuel) affiche les
sélections SmartControl Premium pour
Select Preset (Choisir préréglage) et Tune
Display (Régler affichage) dans le menu
contextuel du bureau (clic avec le bouton
droit). Désactivé supprime SmartControl
Premium du menu contextuel (clic avec le
bouton droit).

* Licone Enable Task Tray (Activer barre
des taches) est coché (activé) par défaut.
Enable Context Menu (Activer le menu
contextuel) affiche le menu de la barre
des taches pour SmartControl Premium.
Cliquez avec le bouton droit sur l'icéne de
la barre des taches pour afficher les options
du menu pour Help (l'aide) et Technical
Support (l'assistance technique). Check
for Update(Vérifier mise a jour), A About



(propos) et Exit (Quitter). Lorsque le menu
Enable Task Tray (Activer barre des taches)
est désactivé, I'icéne de la barre des taches

Option>Auto Pivot (Pivot automatique).

] SmartControl Premium X

SmartControl Premium PHILIPS

n'affiche que Exit (Quitter).

Auto Pivot

* Run at Startup (Exécuter au démarrage) = o
est coché (activé) par défaut. En cas de st pofencs PRt
désactivation, SmartControl Premium n'est \ i

pas lancé au démarrage ou reste dans la
barre des taches. Pour lancer SmartControl
Premium, utilisez le raccourci depuis le

Color. Auto Pivot

\g e

§

B
bureau ou la liste des programmes. Si cette i &
case est décochée (désactivée), aucun e

préréglage ne se charge au démarrage,
méme s'il a été défini comme devant |
s'exécuter au démarrage.

Options ‘Theft Deterrence

SmartDesktop

Hep 100° 2700

* Activer le Mode transparence (Windows 7,

Vista, XP). Par défaut : 0% opaque.
Options>Audio - n'est disponible que lorsque
vous choisissez Volume dans le menu déroulant
Options.

Options>Input (Entrée) - n'est disponible que
lorsque vous choisissez Input (Entrée) dans le
menu déroulant Options. Sur un écran non pris
en charge, mais compatible DDC/CI, seuls les
onglets Help (Aide) et Options sont disponibles.
Aucun autre onglet de SmartControl Premium
n'est disponible.

Sur un écran non pris en charge, mais
compatible DDC/C], seuls les onglets Help
(Aide) et Options sont disponibles.
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Your diplay has mutle inputs (connections on back
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Volume 80
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\ 5 = k> Hep Diplay Port.

Hep Undo

» Affiche le panneau d'instructions Source
et le paramétrage actuel de la source
d'entrée.

* En mode affichage d'entrée simple, ce
panneau n'est pas visible.
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Options>Theft Deterrence (Systéme
antivol) - Le panneau Theft Deterrence
(Systéme antivol) n'est disponible

que lorsque vous sélectionnez Mode
antivol dans le menu déroulant Plug-in
(Branchements).

] SrartCotrFemiom 7%

SmartControl Premium PHILIPS

Theft Deterrence

Adiust preferences

\5/ Audio

Color

g ot

Eco Power

%

Options Theft Deterrence

SmartDesktop
Thet Daterrence Off

Hop on

Pour activer Theft Deterrence (le systéme
antivol), cliquez sur le bouton On (Marche) et
I'écran suivant s'affichera :

Saisissez un PIN de 4 a 9 chiffres
seulement.

Une fois le PIN saisi, le fait d'appuyer sur
le bouton Accept (Accepter) affiche une
boite de dialogue sur la page suivante.

Minutes minimum réglé sur 5. Le curseur
est réglé sur 5 par défaut.

Inutile d'attacher I'écran a un autre
dispositif pour entrer en mode Theft
Deterrence (Systéme antivol).

Apres la création du PIN, le panneau Theft
Deterrence (Systéme antivol) indique Theft
Deterrence Enabled (Systéme antivol activé) et
affiche le bouton PIN Options (Options PIN) :

Theft Deterrence Enabled (Systéme antivol
activé) s'affiche.

Désactiver le Theft Deterrence (Systeme
antivol) ouvre I'écran de la page suivante.

Le bouton PIN Options (Options PIN)
n'est disponible qu'apres avoir crée le PIN.

Ce bouton permet d'accéder au site Web
de PIN sécurisé.

Menu Help (Aide)

Help>User Manual (Aide>Manuel d'utilisation)
- n'est disponible que lorsque vous choisissez
User Manual (Manuel d'utilisation) dans le menu
déroulant Help (Aide). Sur un écran non pris
en charge, mais compatible DDC/CI, seuls les
onglets Help (Aide) et Options sont disponibles.

A — 7%

SmartControl Premium PHILIPS

Adjust

Color

a

Eco Power

Optons

Help User Manual Tech. Support

Help (Aide)>Version - n'est disponible que
lorsque vous choisissez Version dans le menu
déroulant Help (Aide). Sur un écran non pris

en charge, mais compatible DDC/CI, seuls les
onglets Help (Aide) et Options sont disponibles.
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Context Sensitive menu (Menu sensible au
contexte)

Le Context Sensitive menu (Menu sensible

au contexte) est Activé par défaut. Si Enable
Context Menu (Activer le menu contextuel) est
coché dans le panneau Options>Preferences
(Préférences), le menu est alors visible.

E] SmartControf Fremum
Select Presst L4
Tune Display

Power Saver 4

Office
Photo
Movie
Text
Gramme
Economyr

Le Context Menu (menu contextuel) présente
quatre entrées :

SmartControl Premium - si sélectionné,
I'écran About (A propos) s'affiche.

Select Preset (Choisir préréglage) -
présente un menu hiérarchique des
préréglages enregistrés pour une utilisation
immédiate. La marque « coché » indique le
préréglage actuellement sélectionné. Il est
également possible de choisir le Factory
Preset (Préréglage usine) depuis le menu
déroulant.

Tune Display (Régler affichage) - ouvre

le panneau de commande SmartControl
Premium.

Smartlmage - Vérifie les réglages existants
: Off (Arrét), Office (Bureau), Photo, Movie
(Film), Game (Jeux), Economy (Economie).

Menu Barre des taches activé

Le menu barre des taches s'affiche en cliquant
avec le bouton droit sur l'icéne SmartControl
Premium, depuis la barre des taches. Cliquez
avec le bouton gauche pour lancer I'application.

Find Windows L4
Desktop Partition  »
Tdentify Partition
Align On

Help

Techmnical Support
Check for Tpdate
About

I Ezat a

La barre des taches présente cing entrées :

* Help (Aide) - acces au fichier du manuel
d'utilisation : Ouvre le fichier du manuel
d'utilisation en utilisant la fenétre du
navigateur par défaut.

*  Technical Support (Assistance technique) -
Affiche la page de I'assistance technique.

*  Check for Update (Contréler les mises
a jour) - ouvre la page de renvoi PDI et
Vvérifie la version de I'utilisateur par rapport
a la derniére version disponible.

+  About (A propos) - affiche les informations
détaillées de référence : version du produit,
informations sur la publication et nom du
produit.

*  Exit (Quitter) - Ferme SmartControl
Premium

Pour exécuter SmartControl Premium une
nouvelle fois, sélectionnez SmartControl
Premium dans le menu Program (Programmes),
double-cliquez sur l'icéne PC de bureau ou
redémarrez le systeme.

PHILIPS

SmartControl Premium

SmartControl
Version 2.10
dtune-plp-R2011-08-15-1133-18
Copyright ® 1993-2011 Portrait Displays, Inc.
Patents Pending
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Menu Barre des tiches désactivé

Lorsque la Barre des taches est désactivée
dans le dossier des préférences, seul le

choix Exit (Quitter) est disponible. Pour
supprimer complétement SmartControl
Premium de la barre des taches, désactivez
Run at Startup (Exécuter au démarrage) sous
Options>Preferences (Préférences).

© Remarque

Toutes les illustrations de cette section sont
données a titre de référence uniquement. La
version du logiciel SmartControl peut étre
modifiée sans préavis.Veuillez toujours vérifier
le site Web officiel de Portrait www.portrait.
com/dtune/phl/enu/index pour télécharger la
derniere version du logiciel SmartControl.

3.4 Guide SmartDesktop

El SmartDesktop

SmartDesktop est dans SmartControl Premium.

Installez SmartControl Premium et choisissez
SmartDesktop dans les Options.

[&] smartControl Frermium I

Premium
SmartControl Premiy PHILIPS
SmartDesklop
Select deskkop partiioning mode.
W Algn to partiion
Adjust n
Auta Pivot
Colot
= = E] [
Input Even Tiok Verticl
\g & B
Eco : 2 Rght Vertical Laft verticl
i -~ —
\Q Theft Detenienca Botsom Hortortal Top Horzonta
‘Options
. oo -
{ off
Help identfy

» Align to partition check box (La case a
cocher Aligner) sur la partition permet
I'alignement automatique de la fenétre
lorsqu’elle est glissée dans la partition
définie.
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Sélectionnez la partition souhaitée en
cliquant sur l'icéne. La partition sera
appliquée sur le bureau et 'icone sera en
surbrillance.

Identify (Identifier) offre un moyen rapide
pour afficher la grille.

oR

L



www.portrait.com/dtune/phl/enu/index
www.portrait.com/dtune/phl/enu/index

E1 Glisser-et déposer des fenétres

Une fois les partitions configurés et Aligner

sur la partition sélectionnée, une fenétre

peut étre glissée dans la zone et elle sera
automatiquement alignée. Lorsque la fenétre et
le curseur de la souris sont dans la zone, la zone
passe en surbrillance.

© Remarque

Si'le contour de la zone n'est pas visible lorsque
vous faites glisser la fenétre, « Afficher le
contenu des fenétres pendant leur déplacement
» est désactivé. Pour activer :

1. Control Panel (Dans le Panneau) de
configuration, cliquez sur System (Systeme).

2. Cliquez sur Advanced system settings
(Parameétres systéme avancés) (pour Vista
& Win7 OS, il se trouve dans le volet de
gauche)

3. Dans la section Performances, cliquez sur
Performance (Paramétres).

4. Dans la bofte, cochez Show window
contents (Afficher le contenu) des fenétres
pendant leur déplacement, et cliquez sur
OK.

20

Autre chemin alternatif :
Vista:

Control Panel (Panneau de configuration) >
Personalization (Personnalisation) > Window
Color and Appearance (Couleur et apparence
des fenétres) > Cliquez sur « Open Classic
appearance properties for more color options
» (Ouvrir les propriétés d'apparence classique
pour des options de couleurs supplémentaires)
> Cliquez sur le bouton « Effects » (Effets) >
cochez Afficher le contenu des fenétres pendant
leur déplacement.

XP:

Display Properties (Propriétés d'affichage) >
Appearance (Apparence) > Effects... (Effets...) >
cochez Afficher le contenu des fenétres pendant
leur déplacement.

Win7:

Aucun autre chemin alternatif disponible.



El Options de la barre de titre

Partition du bureau est accessible a partir de la
barre de titre de la fenétre active. Cela foumnit
un moyen rapide et facile de gérer le bureau
ainsi que d'envoyer une fenétre quelconque
vers une partition sans avoir a glisser-déposer.
Déplacez le curseur dans la barre titre de la
fenétre active pour accéder au menu déroulant.

1 Menu de clic-droit

Cliquez-droit sur l'icéne Partition du bureau
pour afficher le menu déroulant.

Find Windows »
Desktop Partition
Identify Partition
Align OFf

brifor help = X

Exit

| B Sragt 5 Vindow

* Find Windows (Trouver les fenétres)
— Dans certains cas, I'utilisateur peut
avoir envoyé plusieurs fenétres vers la
méme partition. Find Windows (Trouver
Windows) affichera toutes les fenétres
ouvertes et déplacera la fenétre choisie en
premier plan.

* Desktop Partition (Partition du bureau)
— Desktop Partition (Partition du
bureau) affiche la partition actuellement
sélectionnée et permet a I'utilisateur
de basculer rapidement vers I'une
des partitions présentées dans la liste
déroulante.

b@d'ﬂ-u ®

Hil
" mll
&

SmartDesktop Guide

[
!

S RENT ENC]

in SmanContral Pre Install SmarControl Premium and select

‘SmantDesktop from Options

lxm

(e
SmartControl Premivm PHILIPS
=) Remarque

[

Si plus d'un affichage est connecté, I'utilisateur
peut choisir l'affichage ciblé pour changer la
partition. Licone en surbrillance représente la
partition active actuelle.

* Identify Partition (Identifier la partition)
— Affiche la grille contour sur le bureau
pour la partition actuelle.

+  Align On/Align Off (Aligner activé/Aligner
désactivé) — Active/désactive la fonction
d'alignement automatique par glisser-
déplacer.

» Exit (Quitter) — Desktop Partition (Ferme
Partition) du bureau et Display Tune
(Régler I'affichage). Pour réinitialiser; lancer
Display Tune (Régler l'affichage) depuis
le menu Démarrer ou le raccourci sur le
bureau.

H Menu de clic-gauche

Cliquez-gauche sur l'icdne Partition du bureau
pour envoyer rapidement la fenétre active vers
une partition quelconque sans avoir a glisser-
déplacer. Relachez la souris pour envoyer la
fenétre vers la partition en surbrillance.

PP

Ve @ qusswdt for help |+

voA-Bina- 9w

|,

A Clic-droit sur la barre des taches

La barre des taches contient également la
plupart des fonctionnalités prises en charge
dans la barre de titre (a I'exception de I'envoi
automatique d'une fenétre vers une partition).



L
L

[ ]
|

Bright Light

Dim Light

Help

Technical Support
Check for Update
About

Exit

Find Windows (Trouver les fenétres)

— Dans certains cas, I'utilisateur peut

avoir envoyé plusieurs fenétres vers la
méme partition. Find Windows (Trouver
Windows) affichera toutes les fenétres
ouvertes et déplacera la fenétre choisie en
premier plan.

Desktop Partition (Partition du bureau) —
Desktop Partition (Partition du bureau)
affiche la partition actuellement
sélectionnée et permet a l'utilisateur

de basculer rapidement vers I'une

des partitions présentées dans la liste
déroulante.

Identify Partition (Identifier la partition)
— Affiche la grille contour sur le bureau
pour la partition actuelle.

Align On/Align Off (Aligner activé/Aligner
désactivé) — Active/désactive la fonction
d'alignement automatique par glisser-
déplacer.
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4. Caractéristiques techniques

Type de dalle d'écran LCD

Rétroéclairage DEL

Taille de la dalle 19,5" L (49,5cm)

Proportions 169

Taille de pixel 0,27 x 0,27 mm

Luminosité 250 cd/m?

SmartContrast 20,000,000:1

Taux de contraste (typique) 1000:1

Temps de réponse (typique) 5ms

Résolution optimale 1600x900 @ 60Hz

Angle de vue 170° (H) / 160° (V) @ Tx Contraste > 10
Couleurs d'affichage 16,7 M

Fréquence de rafraichissement 56 Hz - 76 Hz

vertical

Fréquence horizontale 30 kHz - 83 kHz

sRGB QU

Entrée de signal DVI (Numérique), VGA (Analogique)
Signal d'entrée Synchro séparée, synchro sur vert
Entrée Entrée audio PC

Caractéristiques pratiques

Haut parleur intégré 2Wx2

Fonctions pratiques &P/« /v O/A B/0oK 0}

Anglais, Allemand, Espagnol, Francais, Italien, Hongrois,
Neéerlandais, Portugais, Portugais brésilien, Polonais, Russe,
Suédois, Finlandais, Turc, Tchéque, Ukrainien, Chinois simplifié,
Japonais, Coréen, Grec, Chinois traditionnel

Autres fonctions pratiques Verrouillage Kensington

Compatibilité Plug & Play BEJ(;/CI, sRGB, Windows 7/Windows 8/Vista/XE Mac OSX,

Socle

Langues OSD

Inclinaison -5/+20
Rotation -65/+65
Réglage de la hauteur 110mm
Faites pivoter 90°
200S4LMB
Alimentation
Mode Marche 16,88W (typ.) 19,59W(max)

23



Consommation d'énergie

Tension d'entrée

Tension d'entrée

Tension d'entrée

. CA a 100VCA, CA a 115VCA, CA a 230VCA,
(Méthode de test EnergyStar) S0Lly 60Llz S0Lly
Fonctionnement normal (typique) | 13,05W 13,01W 13,12W
Veille (En attente) 05W (typ.) 05W (typ.) 05W (typ.)
Eteindre 05W (typ.) 05W (typ.) 0,5W (typ.)

Tension d'entrée Tension d'entrée Tension d'entrée
Dissipation thermique® CA a100VCA, CA a 115VCA, CA a 230VCA,
50Hz 60Hz 50Hz

Fonctionnement normal

44,54 BTU/hr

44,40 BTU/hr

44,78 BTU/hr

Veille (En attente)

1,706 BTU/hr

1,706 BTU/hr

1,706 BTU/hr

Eteindre

1,706 BTU/hr

1,706 BTU/hr

1,706 BTU/hr

Voyant DEL d'alimentation

En mode : Blanc, mode En attente/Veille : Blanc (clignote)

Alimentation

Intégré, 100-240VCA, 50-60Hz

Produit avec socle (LxHxP)

Dimensions

479 x 384 x 227 mm

Produit sans socle (LxHxP)

479 x 299 x 48 mm

Produit avec socle 4202 kg
Produit sans socle 1.872 kg
Produit emballé 5991 kg

Plage de température (en
fonctionnement)

Condition de fonctionnement

de 0°Ca 40 °C

Plage de température
(Hors fonctionnement)

de -20°C a 60°C

Humidité relative

de 20% a 80%

Conformité et normes

Approbations réglementaires CE Mark, FCC Class B, EAC,SEMKO, ETL,GS, Certificats TCO

MTBF 30 000 heures

ROHS OUl

EPEAT Silver (www.epeat.net)
Emballage 100% recyclable

Substances spécifiques Boitier 100% sans PVC BFR
EnergyStar OuUl

Boitier
Couleur Noir
Finition Texture
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http://www.epeat.net

© Remarque

1. EPEAT Gold ou Silver n'est valide qu'aux endroits ou Philips a enregistré le produit. Visitez le site
www.epeat.net pour connaitre I'état de I'enregistrement dans votre pays.

2. Ces données sont sujettes a modifications sans préavis. Visitez www.philips.com/support pour
télécharger la derniere version de la brochure.
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4.1 Résolution et modes de
préréglage

El Résolution maximale
1600%900 @ 60Hz (Entrée analogique)
1600%900 @ 60Hz (Entrée numérique)

B Résolution recommandée
1600900 @ 60Hz (Entrée numérique)

Fréquence H. Résolution  FréquenceV.

(KHz) (Hz)
3147 720x400 70.09
3147 640x480 59.94
35.00 640x480 66.67
37.86 640x480 72.81
37.50 640x480 75.00
37.88 800x600 60.32
46.88 800x600 75.00
48.36 1024x768 60.00
60.02 1024x768 75.03
44.77 1280x720 59.86
63.89 1280x1024 60.02
79.98 1280x1024 75.03
60.00 1600x900 60.00
55.54 1600x900 60.00
© Remarque

Veulillez noter que votre moniteur fonctionne
de facon optimale a sa résolution native de
1600x900 @ 60Hz. Pour un affichage optimal,
veuillez suivre cette recommandation quant a la
résolution.
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5. Gestion de I'énergie

Si vous disposez d'une carte vidéo compatible
VESA DPM ou d'un logiciel installé sur votre
PC, le moniteur va automatiquement réduire
sa consommation électrique lorsqu'il n'est
pas utilisé. En cas d'activation d'une touche
du clavier, de manipulation de la souris ou

de détection d'un autre appareil d'entrée, le
moniteur va automatiquement « se réveiller
». Le tableau suivant affiche la consommation
électrique et la signalisation de ladite fonction
d'économie d'énergie :

Définition de la gestion énergétique

D0 Energie| Couleur du
Mode VESA Vidéo H-sync [ V-sync utiisée | voyant DEL
16,88
Actif ACTIVE Oui Oui W Blanc
(typ)
. a 3 05W Blanc
Veille (En attente) | DESACTIVE| Non | Non @p) | (cignote)
Eteint DESACTIVE[ - - | %W pEsacive
(typ)

La configuration suivante est utilisée pour
mesurer la consommation électrique de ce
moniteur.

* Résolution native : 1600x900

» Contraste : 50%

*  Luminosité : 250 nits

* Color temperature (Température de

couleurs) : 6500k avec motif blanc complet

© Remarque
Ces données sont sujettes a modifications sans
préavis.
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6. Informations Concernant
es Réglementations

Lead-free Product

Lead free display promotes

@ environmentally sound recovery
ey and disposal of waste from electrical

and electronic equipment. Toxic

substances like Lead has been eliminated

and compliance with European community's

stringent RoHs directive mandating restrictions

on hazardous substances in electrical and

electronic equipment have been adhered to

in order to make Philips monitors safe to use

throughout its life cycle.

CE Declaration of Conformity

This product is in conformity with the following
standards

*  EN60950-1:2006+A11:2009+A1:20
10+A12:2011 (Safety requirement of
Information Technology Equipment).

»  EN55022:2010 (Radio Disturbance
requirement of Information Technology
Equipment).

* EN55024:2010 (Immunity requirement of
Information Technology Equipment).

»  EN61000-3-2:2006 +A1:2009+A2:2009
(Limits for Harmonic Current Emission).

»  EN61000-3-3:2008 (Limitation of Voltage
Fluctuation and Flicker) following provisions
of directives applicable.

*  2006/95/EC (Low Voltage Directive).

+  2004/108/EC (EMC Directive).

*  2009/125/EC (ErP Directive, EC No.
1275/2008 Implementing Directive
for Standby and Off mode power
consumption) and is produced by a
manufacturing organization on 1SO9000
level.

The product also comply with the following
standards
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1SO9241-307:2008 (Ergonomic
requirement, Analysis and compliance test
methods for electronic visual displays).

GS EK1-2000:2011 (GS mark requirement).

prEN50279:1998 (Low Frequency Electric
and Magnetic fields for Visual Display).

MPR-II (MPR:1990:8/1990:10 Low
Frequency Electric and Magnetic fields).



Federal Communications Commission (FCC)
Notice (U.S. Only)

& This equipment has been tested and found
to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide
reasonable protection against harmful
interference in a residential installation.

This equipment generates, uses and can
radiate radio frequency energy and, if not
installed and used in accordance with the
instructions, may cause harmful interference
to radio communications.

However, there is no guarantee that
interference will not occur in a particular
installation. If this equipment does cause
harmful interference to radio or television
reception, which can be determined by
turning the equipment off and on, the
user is encouraged to try to correct

the interference by one or more of the
following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the
equipment and receiver.

» Connect the equipment into an outlet on
a circuit different from that to which the
receiver is connected.

»  Consult the dealer or an experienced
radio/TV technician for help.
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@ Changes or modifications not expressly
approved by the party responsible for
compliance could void the user's authority
to operate the equipment.

Use only RF shielded cable that was supplied
with the monitor when connecting this monitor
to a computer device.

To prevent damage which may result in fire or
shock hazard, do not expose this appliance to
rain or excessive moisture.

THIS CLASS B DIGITAL APPARATUS MEETS
ALL REQUIREMENTS OF THE CANADIAN
INTERFERENCE-CAUSING EQUIPMENT
REGULATIONS.

FCC Declaration of Conformity

Declaration of Conformity for Products Marked
with FCC Logo,

United States Only

FC

This device complies with Part 15 of the FCC
Rules. Operation is subject to the following two
conditions: (1) this device may not cause harmful
interference, and (2) this device must accept any
interference received, including interference that
may cause undesired operation.

Commission Federale de la Communication
(FCC Declaration)

& Cet équipement a été testé et déclaré
conforme auxlimites des appareils
numériques de class B,aux termes de
I'article 15 Des regles de la FCC. Ces
limites sont concues de facon a fourir
une protection raisonnable contre les
interférences nuisibles dans le cadre d'une
installation résidentielle.

CET appareil produit, utilise et peut émettre
des hyperfréquences qui, si I'appareil n'est
pas installé et utilisé selon les consignes
données, peuvent causer des interférences
nuisibles aux communications radio.



Cependant, rien ne peut garantir I'absence
d'interférences dans le cadre d'une
installation particuliére. Si cet appareil est
la cause d'interférences nuisibles pour

la réception des signaux de radio ou de
télévision, ce qui peut étre décelé en
fermant I'équipement, puis en le remettant
en fonction, |'utilisateur pourrait essayer de
corriger la situation en prenant les mesures
suivantes:

* Réorienter ou déplacer I'antenne de
réception.

* Augmenter la distance entre I'équipement
et le récepteur.

*  Brancher I'équipement sur un autre circuit
que celui utilisé par le récepteur

¢ Demander l'aide du marchand ou d'un
technicien chevronné en radio/télévision.

Toutes modifications n'ayant pas recu
I'approbation des services compétents

en matiére de conformité est susceptible
d'interdire a l'utilisateur 'usage du présent
équipement.

N'utiliser que des cables RF armés pour
les connections avec des ordinateurs ou
périphériques.

CET APPAREIL NUMERIQUE DE LA CLASSE
B RESPECTETOUTES LES EXIGENCES DU
REGLEMENT SUR LE MATERIEL BROUILLEUR
DU CANADA.
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EN 55022 Compliance (Czech Republic Only)

This davice belongs to catagory B devices as described in EN 55022, unless it is spacti-
cally stated that it is a Class A devics on the speciication labal. The following appiies to
devices in Class A of EN 55022 (radius of protection up 1o 30 meters). The ussr of the
devics iz obliged to taks all staps necessary to remove sources of intarfarencs 1o tels-
communication or sther devicss.

Fokud neni na typovém Stitku poitate uvedeno, 28 spadé do do tfidy A podie EN 55022,
spadd automaticky do tfidy B podile EN 55022, Pro zafizenl zefazend do tfidy A (chranné
pésmo 30m) podie EN 55022 plati nésledujicl. Dojde-li k rullen! tslekomunikadnich nebe.
Jinjch zafizani je uZivatal povinnen provést takove opatfgni, aby neni odstranil.

Polish Center for Testing and Certification
Notice

The equipment should draw power from a
socket with an attached protection circuit (a
three-prong socket). All equipment that works
together (computer, monitor, printer, and so on)
should have the same power supply source.

The phasing conductor of the room's electrical
installation should have a reserve short-circuit
protection device in the form of a fuse with a
nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the
power supply cable must be removed from the
power supply socket, which should be located
near the equipment and easily accessible.

A protection mark "B" confirms that the
equipment is in compliance with the protection
usage requirements of standards PN-93/1-42107
and PN-89/E-06251.

Wymagania Polskiege Centrum Badan | Certyfikacji

Kidre powinno

3 patwierilzs cadzinia 2 wyn
wiytkowaiiia i w PN-T A, PR IG5

Pozostale instrukcje bezpieczensiwa

wat kelka abwidu ockranneg 2 wiyceki.
¢ iyt preodiusce -iyloyes ¢

werostasmi lub spod-

cizza wokdl nieg.



North Europe (Nordic Countries) Information

Placering/Ventilation

VARNING:

FORSAKRA DIG OM ATT HUVUDBRYTARE
OCH UTTAG AR LATATKOMLIGA, NAR
DU STALLER DIN UTRUSTNING PAPLATS.

Placering/Ventilation

ADVARSEL:

SORG VED PLACERINGEN FOR, AT NET-
LEDNINGENS STIK OG STIKKONTAKT ER
NEMT TILGANGELIGE.

Paikka/llmankierto

VAROITUS:

SJOITA LAITE SITEN, ETTA VERKKOJOHTO
VOIDAAN TARVITTAESSA HELPOSTI IR-
ROTTAA PISTORASIASTA.

Plassering/Ventilasjon

ADVARSEL:

NAR DETTE UTSTYRET PLASSERES, MA DU
PASSE PA AT KONTAKTENE FOR ST@MTIL-
FORSEL ER LETTE A NA.

Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht
den in der "Verordnung Uber den Schutz vor
Schiden durch Rontgenstrahlen” festgelegten
Vorschriften.

Auf der Rickwand des Gerites befindet sich

ein Aufkleber, der auf die Unbedenklichkeit der
Inbetriebnahme hinweist, da die Vorschriften
Uber die Bauart von Storstrahlern nach Anlage
a5 Abs. 4 der Rontgenverordnung erflllt sind.

Damit Ihr Monitor immer den in der Zulassung
geforderten Werten entspricht, ist darauf zu
achten, dal3

1. Reparaturen nur durch Fachpersonal
durchgefiihrt werden.
2. nur original-Ersatzteile verwendet werden.

bei Ersatz der Bildréhre nur eine
bauartgleiche eingebaut wird.

Aus ergonomischen Griinden wird empfohlen,
die Grundfarben Blau und Rot nicht auf dun-
klem Untergrund zu verwenden (schlechte
Lesbarkeit und erhohte Augenbelastung bei zu
geringem Zeichenkontrast wéren die Folge).
Der arbeitsplatzbezogene Schalldruckpegel
nach DIN 45 635 betrdgt 70dB (A) oder weni-
ger.

() ACHTUNG: BEIM AUFSTELLEN
DIESES GERATES DARAUF
ACHTEN, DAB NETZSTECKER UND
NETZKABELANSCHLUB LEICHT
ZUGANGLICH SIND.



China RoHS

The People's Republic of China released a
regulation called "Management Methods for
Controlling Pollution by Electronic Information
Products" or commonly referred to as China
RoHS. All products produced and sold for China
market have to meet China RoHS request.
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The European Energy Label informs you on
the energy efficiency class of this product.
The greener the energy efficiency class of this
product is the lower the energy it consumes.

On the label, you can find the energy efficiency
class, the average power consumption of

this product in use and the average energy
consumption for 1 year.

& Note:

The EU Energy Label will be ONLY applied on
the models bundling with HDMI and TV tuners.



7. Assistance client et
Garantie

7.1 Politique de Philips relative aux
pixels défectueux des écrans
plats

Philips s'efforce de livrer des produits de la plus
haute qualité. Nous utilisons les processus de
fabrication les plus avancés de I'industrie et les
méthodes les plus strictes de contréle de la
qualité. Néanmoins, des défauts au niveau des
pixels ou des sous-pixels sont parfois inévitables

dans les dalles TFT utilisées dans les écrans plats.

Aucun fabricant ne peut garantir que tous les
panneaux seront sans pixel défectueux, mais
Philips garantit que tout moniteur avec un
nombre inacceptable de défauts sera réparé
ou remplacé sous garantie. Cet avis explique
les différents types de défauts de pixels et
définit les niveaux de défauts acceptables pour
chacun des ces types. Pour bénéficier de la
réparation ou du remplacement sous garantie,
le nombre de défauts de pixels sur un panneau
TFT doit dépasser ces niveaux acceptables. Par
exemple, pas plus de 0,0004% des sous-pixels
d'un moniteur ne peuvent étre défectueux.

En outre, étant donné que certains types ou
combinaisons de défauts de pixels sont plus
remarqués que d'autres, Philips détermine des
niveaux de qualité encore plus élevés. Cette
garantie est valable dans le monde entier.

sous-pixels

R G B [

Pixels

Pixels et sous-pixels

Un pixel, ou élément d'image, est composé de
trois sous-pixels correspondants aux couleurs
primaires rouge, vert et bleu. Une image se
compose d'un grand nombre de pixels. Quand
tous les sous-pixels d'un pixel sont allumés, les
trois sous-pixels colorés apparaissent ensemble
comme un seul pixel blanc. Quand ils sont tous
éteints, les trois sous-pixels colorés apparaissent
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ensemble comme un seul pixel noir. Les autres
combinaisons de sous-pixels allumés et éteints
apparaissent comme les pixels individuels
d'autres couleurs.

Types de défauts de pixels

Les défauts de pixels et de sous-pixels
apparaissent sur |'écran de différentes facons. I
existe deux catégories de défauts de pixels et
plusieurs types de défauts de sous-pixels dans
chaque catégorie.

Défauts de points brillants

Les points défectueux brillants sont des pixels
ou sous-pixels toujours allumés ou 'activés'. Un
pixel brillant est donc un sous-pixel qui ressort
du fond sombre de I'écran.Voici les types de
pixels brillants défectueux.

Un sous-pixel rouge, vert ou bleu allumé.

I ¢

Deux sous-pixels allumés adjacents :
- Rouge + Bleu =Violet
- Rouge +Vert = Jaune
- Vert + Bleu = Cyan (Bleu pale)

Trois sous-pixels adjacents allumés (un pixel
blanc).




© Remarque

Un pixel brillant rouge ou bleu a une luminosité
supérieure a 50 % par rapport aux pixels
environnants, tandis qu'un pixel brillant vert est
30 % plus lumineux que les pixels environnants.

Défauts de points sombres

Les points défectueux sombres sont des pixels

ou sous-pixels toujours noirs ou « éteints ». Un
pixel sombre est donc un sous-pixel qui ressort
du fond clair de I'écran.Voici les types de pixels
sombres défectueux.

Proximité des défauts de pixels

Du fait que des défauts de méme type
provenant de pixels et sous-pixels proches les
uns des autres peuvent étre plus facilement
remarqués, Philips spécifie aussi des tolérances
pour la proximité des défauts de pixels.

Tolérances des défauts de pixels

Pour bénéficier, pendant la période de garantie,
d'une réparation ou d'un remplacement en
raison de défauts de pixels, le panneau TFT d'un
écran plat Philips doit avoir des défauts de pixels
et sous-pixels qui dépassent les tolérances
répertoriées dans les tableaux suivants.

DEFAUTS DES POINTS LUMINEUX NIVEAU ACCEPTABLE
1 sous-pixel éclairé 3
2 sous-pixels adjacents éclairés 1
3 sous-pixels adjacents éclairés (un pixel blanc) 0
Distance entre deux points lumineux défectueux* >15mm
Total des points lumineux défectueux, tous types confondus 3
POINTS NOIRS DEFECTUEUX NIVEAU ACCEPTABLE
1 sous-pixel noir 5 ou moins
2 sous-pixels noirs adjacents 2 ou moins
3 sous-pixels noirs adjacents 0
Distance entre deux points noirs défectueux* >15mm
Nombre total de points défectueux de tous types 5 ou moins
Nombre total de points lumineux ou noirs défectueux de tous 5 ou moins
types
© Remarque

1. 1 ou 2 sous-pixels adjacents = 1 point défectueux

2. Le moniteur est conforme a la norme 1SO9241-307. Conforme classe-I. (IS5O9241-307 : méthodes
de test sur 'exigence ergonomique, I'analyse et la conformité des écrans électroniques)

w

1SO9241-307 est le successeur de la norme connue sous le nom de ISO13406, retirée par

I'Organisation Internationale de la normalisation (International Organisation for Standardisation, ou

ISO) le :2008-11-13.
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7.2 Assistance client & Garantie

Pour plus d'informations sur la garantie et le support additionnel pour votre région, veuillez consultez le
site www.philips.com/support.Vous pouvez également contacter le service d'assistance a la clientéle de

Philips de votre région, a I'un des numéros ci-dessous.

Informations de contact pour la région EUROPE DE L'EST :

Pays CSP Numéro Hotline Prix Heures d’ouverture

Austria RTS +43 0810 000206 €007 Mon to Fri:9am - 6pm
Belgium Ecare +32 078 250851 €0.06 Mon to Fri:9am - 6pm
Cyprus Alman 800 92 256 Free of charge | Mon to Fri:9am - 6pm
Denmark Infocare +45 3525 8761 Local call tariff | Mon to Fri:9am - 6pm
Finland Infocare +358 09 2290 1908 | Local call tariff [ Mon to Fri: 9am - 6pm
France Mainteq +33 082161 1658 €0.09 Mon to Fri:9am - 6pm
Germany RTS +49 01803 386 853  |€0.09 Mon to Fri:9am - 6pm
Greece Alman +30 00800 3122 1223 | Free of charge [ Mon to Fri:9am - 6pm
Ireland Celestica +353 01 601 1161 Local call tariff [ Mon to Fri:8am - 5pm
Italy Anovo ltaly [ +39 840 320 041 €0.08 Mon to Fri:9am - 6pm
Luxembourg Ecare +352 26 84 30 00 Local call tariff | Mon to Fri:9am - 6pm
Netherlands Ecare +31 0900 0400 063 € 0.10 Mon to Fri:9am - 6pm
Norway Infocare +47 2270 8250 Local call tariff | Mon to Fri: 9am - 6pm
Poland MSI +48 0223491505 Local call tariff | Mon to Fri:9am - 6pm
Portugal Mainteq 800 780 902 Free of charge | Mon to Fri:8am - 5pm
Spain Mainteq +34 902 888 785 €010 Mon to Fri:9am - 6pm
Sweden Infocare +46 08 632 0016 Local call tariff [ Mon to Fri:9am - 6pm
Switzerland ANOVO CH | +41 02 2310 2116 Local call tariff [ Mon to Fri:9am - 6pm
United Kingdom | Celestica +44 0207 949 0069 Local call tariff | Mon to Fri:8am - 5pm

Informations de contact pour la Chine :

Pays
China

Centre d'appel
PCCW Limited

Numéro clientéle
4008 800 008

Informations de contact pour 'AMERIQUE DU NORD :

Pays Centre d'appel Numéro clientéle
USA. EPl-e-center (877) 835-1838
Canada EPl-e-center (800) 479-6696



http://www.philips.com/support

Informations de contact pour la région EUROPE CENTRAL ET EUROPE DE L'EST :

Pays Centre d'appel CSP Numéro clientéle
4
s |0 |m S
Bulgaria NA LAN Service +359 2 960 2360
Croatia NA MR Service Ltd +385 (01) 640 1111
Czech Rep. NA Asupport 420 272 188 300
o |w o [msmRey
Georgia NA Esabi +995 322 91 34 71
+36 1 814 8080(General)
Hungary NA Profi Service +36 1814 8565(For AOC&Philips
only)
Kazakhstan NA Classic Service ll.c. | +7 727 3097515
4
Latvia NA ServiceNet LV +§;1 g;g:ggzz
Lithuania NA UAB Servicenet Ig;g ;ZO%%?Bé?é)gf;ﬁﬁfpl)s)
Macedonia NA AMC +389 2 3125097
Moldova NA Comel +37322224035
Romania NA Skin +40 21 2101969
Russia NA CPS +7 (495) 645 6746
Serbia&Montenegro | NA Kim Tec d.o.o. +381 11 20 70 684
Slovakia NA Datalan Service +421 2 49207155
Slovenia NA PC H.and +386 1 530 08 24
the republic of Belarus | NA ServiceBy + 37517 284 0203
Turkey NA Tecpro +90 212 444 4 832
Ukraine NA Topaz +38044 525 64 95
Ukraine NA Comel +380 5627444225

Informations de contact pour la région AMERIQUE LATINE :

Pays

Brazil

Argentina

Centre d'appel

Vermont

Numéro clientéle
0800-7254101

0800 3330 856
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Informations de contact pour la région Asie-Pacifique/Moyen Orient/Afrique :

Pays

Australia

ASP
AGOS NETWORK PTY LTD

Numéro clientele
1300 360 386

Heures d’ouverture
Mon.~Fri. 9:00am-5:30pm

New Zealand

Visual Group Ltd.

0800 657447

Mon.~Fri. 8:30am-5:30pm

Ltd

Hong Kong Company: Smart Pixels Hong Kong; Mon.~Fri. 9:00am-6:00pm
Maca Technology Ltd Tel: +852 2619 9639 Sat. 9:00am-1:00pm
. gy L Macau:Tel: (853)-0800-987 -7am- TP
. Tel: 1 800 425 6396 .
India REDINGTON INDIA LTD SMS: PHILIPS to 56677 Mon.~Fri. 9:00am-5:30pm
+62-21-4080-9086 (Customer N ; A
ndonesia | PTCORMIC SERVISINDO | Hotline) :43?86-2;608'30_1 200,
PERKASA +6278888-O1—9086 (Customer Fri. 08:30-11:30; 13:00-17:30
Hotline)
. Mon.~Fri. 9:00am-5:30pm
Korea Alphascan Displays, Inc 1661-5003 Sat. 9:00am-1:00pm
. . Mon.~Fri. 8:15am-5:00pm
Malaysia R-Logic Sdn Bhd +603 5102 3336 Sat. 8:30am-12:30am
Pakistan TVONICS Pakistan +92-213-6030100 Sun.~Thu. 10:00am-6:00pm
Philips Electronics Singapore :
: " Mon.~Fri. 9:00am-6:00pm
Singapore Pte Ltd (Philips Consumer Care | (65) 6882 3966 Sat. 9:00am-1:00pm
Center)
Taiwan FETEC.CO 0800-231-099 Mon.~Fri. 09:00 - 18:00
Thailand ﬁjs Computer System Co. | 65y 934.5498 Mon.~Fri. 8:30am~05:30pm
South Africa | Computer Repair Technologies |011 262 3586 Mon.~Fri. 8:00am~05:00pm
Israel Eastronics LTD 1-800-567000 Sun.~Thu. 08:00-18:00
+84 8 38248007 Ho Chi Minh
FPT Service Informatic City 2 G ) ;
Vietnam Company Ltd. - Ho Chi Minh | +84 5113.562666 Danang City :47‘?;‘6 SZ: g;ggjigg' 13:30-
City Branch +84 5113.562666 Can tho T '
Province
T i ALl (02) 655-7777; 6359456 Mon.~Fri. 8:30am~5:30pm
Solutions ,Inc.
Armenia
Azerbaijan
Georgia Firebird service centre +97 14 8837911 Sun.~Thu. 09:00 - 18:00
Kyrgyzstan
Tajikistan
Uzbekistan | 0rike Plus Private Enterprise | o507 5784450 Mon.~Fri. 09:00 - 18:00

Turkmenistan

Technostar Service Centre

+(99312) 460733, 460957

Mon.~Fri. 09:00 - 18:00

Japan

T4 TS RE=F— - R
—hEH—

0120-060-530

Mon.~Fri. 09:00 - 18:00
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8. Guide de dépannage et
Foire Aux Questions

8.1 Recherches de causes de pannes

Cette page reprend les problemes pouvant
étre corrigés par un utilisateur. Si le probleme
persiste méme apres avoir appliqué ces
corrections, contactez un représentant du
service client Philips.

El Problémes les plus fréquents

Aucune image (le voyant DEL d’alimentation
ne s'allume pas)

* Assurez-vous d'avoir bien branché le
cordon d'alimentation dans une prise, et a
I'arriere du moniteur.

*  Puis contrdlez le bouton marche/arrét a
I'avant du moniteur. S'il est en position
éteint, appuyez pour le mettre en position
allumé.

Aucune image (Le voyant DEL d’alimentation
est blanc)
*  Vérifiez que l'ordinateur est allumé.

«  Vérifiez que le cable signal est bien branché
sur votre ordinateur.

*  Assurez-vous que le cable du moniteur ne
présente pas de broches tordues du cété
connexion. Si c'est le cas, il faut réparer ou
remplacer le cable.

* La fonction d'économie d'énergie est peut-
étre activée.

L'écran affiche

Attention

Check cable connection

*  Vérifiez que le cable du moniteur est bien
relié a votre ordinateur. (Veuillez également
vous référer au Guide de démarrage
rapide).
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e Vérifiez I'absence de broches tordues au
niveau du cable du moniteur.

*  Vérifiez que I'ordinateur est allumé.

Le bouton Auto ne marche pas

* La fonction auto ne marche qu'en mode
VGA-Analog (VGA-Analogique). Si les
résultats ne sont pas bons, vous pouvez

faire un ajustement manuel avec le menu
OSsD.
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La fonction Auto ne marche pas dans le mode
DVI-Digital (DVI-Numérique) car elle est inutile
dans ce mode.

Signes visibles de fumée ou d'étincelles
*  N'effectuez aucun dépannage.

¢ Débranchez immédiatement le moniteur
de la prise d'alimentation secteur pour
votre sécurité.

» Contactez immédiatement le service-client
de Philips.

E1 Problémes relatifs a I'image

L'image n'est pas centrée

*  Réglez la position de I'image en utilisant la
fonction « Auto » dans le menu OSD.

*  Réglez la position de I'image en utilisant
la fonction Phase/Clock (Horloge) du
Setup (installation) dans les commandes
principales du menu a I'écran. Elle ne
fonctionne qu'en mode VGA.

L'image vibre sur I'écran
* Controlez le branchement du cable signal
au niveau de la carte graphique ou du PC.

Un scintillement vertical apparait

*  Réglez I'image en utilisant la fonction
«Auto» dans le menu OSD.

«  Eliminez les barres verticales en utilisant
la fonction Phase/Clock (Horloge) Setup



(d'installation) dans les commandes
principales du menu a I'écran. Elle ne
fonctionne qu'en mode VGA.

Un scintillement horizontal apparait

* Réglez I'image en utilisant la fonction
«Auto» dans le menu OSD.

*  Eliminez les barres verticales en utilisant
la fonction Phase/Clock (Horloge) Setup
(d'installation) dans les commandes
principales du menu a I'écran. Elle ne
fonctionne qu'en mode VGA.

I'image apparait floue, imparfaite ou trop
sombre

* Réglez le contraste et la luminosité en
utilisant le menu a I'écran.

Une «image rémanentey, en «surimpressiony
ou «image fantdmey apparait lorsque
I'alimentation est coupée.

» L'affichage sans interruption d'image
statique ou immobile sur une longue
période peut engendrer une « rémanence
a l'extinction », également appelée « image
résiduelle » ou « image fantdme » sur
votre écran. Ces images « rémanentes
», € en surimpression » ou « fantdbmes
» sont un phénomene bien connu de la
technologie des panneaux LCD. Dans
la plupart des cas, cette « rémanence a
I'extinction », ou « image résiduelle » ou «
image fantdbme » disparait progressivement
une fois l'alimentation éteinte.

* Activez systématiquement un programme
économiseur d'écran en mouvement
lorsque votre écran n'est pas sollicité.

* Activez systématiquement une application
de rafraichissement périodique de votre
moniteur LCD pour afficher un contenu
statique fixe.

* Les symptdmes de « brllure », d'« image
résiduelle » ou d'« image fantéme » ne
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disparaitront pas et ne pourront pas

&tre réparés si vous n'utilisez pas un
économiseur d'écran ou une application
de rafraichissement périodique de I'écran.
Ce dommage n'est pas couvert par votre
garantie.

L'image apparait déformée. Le texte est flou
ou brouillé.

* Réglez la résolution d'affichage du PC sur
celle recommandée pour le moniteur.

Des points verts, rouges, bleus, sombres et
blancs apparaissent a I'écran

* Les points rémanents sont une
caractéristique normale du cristal liquide
utilisé dans la technologie d'aujourd'hui ;
veuillez lire la section relative aux pixels
défectueux pour plus de détails.

Le voyant « Marche » est trop puissant et me
géne.
*  Vous pouvez ajuster le voyant « Marche
» en utilisant Configuration DEL
dalimentation dans le menu OSD.

Pour une assistance plus approfondie, veuillez
consulter la liste des Centres d'information aux
clients et contacter un représentant du service
client Philips.

8.2 Questions fréquentes -
SmartControl Premium

Q1.  J'ai remplacé le moniteur de mon
PC par un nouveau moniteur et
SmartControl Premium ne marche

plus. Que faire ?

Rallumez votre PC et vérifiez si
SmartControl Premium marche
correctement. Si ce n'est pas le cas,
vous devrez supprimer puis réinstaller
SmartControl Premium pour garantir la
bonne installation du pilote.

Rép.:

Les fonctions de SmartControl
Premium marchaient correctement
avant mais ne marchent plus
maintenant. Que faire ?

Q2.



Rép.:

Qs.

Rép.:

Si vous avez effectué les opérations
suivantes, il faudra peut-étre réinstaller
le pilote du moniteur.

Remplacez la carte graphique par une
autre

Mettez a jour le pilote vidéo

Activités sur le systéme d'exploitation, telles
que service pack ou patch

Exécutez la mise a jour de Windows ainsi
que le pilote du moniteur et/ou vidéo mis
a jour

Windows a été redémarré alors que le
moniteur était hors tension ou déconnecté.

Pour résoudre le probléme, cliquez avec le
bouton droit sur My Computer (Poste de
travail), puis sur Properties (Propriétés) ->
Hardware (Matériel)-> Device Manager
(Gestionnaire de périphériques).

Si'la mention « Plug and Play Monitor »
(Moniteur Plug-and-Play) accompagne
I'icdbne du Monitor (moniteur), il vous
faudra procéder a une nouvelle installation.
Désinstallez simplement SmartControl
Premium et réinstallez-le.

Apreés avoir installé SmartControl
Premium, lorsque je clique sur l'onglet
SmartControl Premium, rien ne se
passe ou un message d'erreur apparait.
Que s'est-il passé ?

Il se peut que votre carte graphique ne
soit pas compatible avec SmartControl
Premium. Si votre carte graphique fait
partie des margues susmentionnées,
essayez de télécharger le pilote de la
carte graphique le plus récent depuis
le site Internet correspondant a ladite
marque. Installez le pilote. Désinstallez
SmartControl Premium, et réinstallez-le
a nouveau.

Si cela ne fonctionne toujours pas, c'est
que la carte graphique n'est pas prise
en charge.Veuillez visiter le site Web
de Philips pour Vérifier si une nouvelle
version du pilote de SmartControl
Premium est disponible.
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Q4.

Rép.:

Q5.

Rép.:

Lorsque je clique sur Product
Information (Informations produit),
toutes les informations n'apparaissent
pas. Pourquoi ?

Le pilote de votre carte graphique

n'est peut-&tre pas la toute derniere
version disponible et ne prend donc
pas totalement en charge l'interface
DDC/CI. Essayez de télécharger la toute
derniére version du pilote de la carte
graphique depuis le site Internet de la
marque de la carte. Installez le pilote.
Désinstallez SmartControl Premium et
réinstallez-le a nouveau.

Attention

Theft mode enabled

J'ai égaré mon code PIN pour la
fonction Theft Deterrence (Systeme
antivol). Que faire ?

Le service client de Philips a le droit
de vous demander une preuve
d'identification et d'autorisation, pour
Vérifier si vous étes le propriétaire 1égal
du moniteur.

8.3
Q1:

Rép.:

Questions générales

Lorsque j'installe mon moniteur, que

faire lorsque I'écran affiche « Cannot
display this video mode » (Impossible
d'afficher ce mode vidéo)?

Résolution recommandée pour ce
moniteur : 1600x900 @ 60 Hz.

Débranchez tous les cables, puis branchez
votre PC sur le moniteur que vous utilisiez
précédemment.

Dans Windows Start Menu (Menu
Démarrer de Windows), choisissez Settings/
Control Panel (Parameétres/Panneau de
configuration) Dans Control Panel Window



Q2:

Rép.:

Q3:

Rép.:

(Fenétre du Panneau de configuration),
sélectionnez l'icdne Display (Affichage)
Dans Display Control Panel (Panneau

de configuration Affichage), sélectionnez
I'onglet « Settings » (Parametres). Dans
I'onglet Paramétres, dans la bofte « desktop
area » (zone bureau), déplacez la réglette
sur 1600x900 pixels.

Ouvrez les «Advanced Propertiesy
(Propriétés avancées) et réglez le Taux de
rafraichissement sur 60 Hz. Cliquez ensuite
sur OK.

Redémarrez votre ordinateur, reprenez les
étapes 2 et 3 et vérifiez que votre PC est
bien réglé sur 1600%900 @ 60 Hz.

Eteignez votre ordinateur. Débranchez
votre ancien moniteur puis reconnectez
votre moniteur LCD Philips.

Mettez votre moniteur sous tension, puis
allumez votre PC.

Quel est le taux de rafraichissement
recommandé pour le moniteur LCD?

Le taux de rafraichissement
recommandé pour les moniteurs LCD
est de 60Hz. En cas de perturbation au
niveau de I'écran, vous pouvez |'ajuster
sur 75Hz pour tenter de supprimer le
brouillage.

A quoi servent les fichiers .inf et .icm
sur le CD-ROM? Comment installer
les pilotes (.inf et .icm) ?

Il s'agit des fichiers correspondant au
pilote de votre moniteur: Suivez les
instructions de votre manuel d'utilisateur
pour installer les pilotes. Au moment
de I'installation de votre moniteur;
votre ordinateur peut vous demander
les pilotes du moniteur (les fichiers
.inf et .icm) ou un disque contenant
les pilotes. Suivez les instructions pour
insérer le CD-ROM inclus dans cet
emballage. Les pilotes du moniteur (les
fichiers .inf et .icm) peuvent s'installer
automatiquement.
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Q4:
Rép.:

Comment ajuster la résolution ?

Le pilote de votre carte graphique et
le moniteur déterminent ensemble
les résolutions disponibles.Vous
pouvez choisir la résolution voulue
depuis le Control Panel (Panneau de
configuration) de Windows®, sous
«Display properties» (Propriétés
d'affichage).

Q5:  Que faire si je m'embrouille pendant
les réglages du moniteur ?

Appuyez simplement sur le bouton OK;
puis sélectionnez «Reset» (Réinitialiser)
pour restaurer tous les parametres
d'origine.

Rép.:

Qé:
Rép.:

L'écran LCD résiste-t-il aux rayures ?

En général, il est recommandé d'éviter
de soumettre la surface du panneau

a un choc excessif et de le protéger
contre les objets émoussés ou pointus.
Lorsque vous manipulez le moniteur,
assurez-vous de ne pas appliquer

de pression ou de force sur le c6té
panneau. Cela pourrait affecter vos
conditions de garantie.

Q7:  Comment nettoyer la surface de
l'‘écran LCD ?

Pour un nettoyage normal, utilisez

un chiffon propre et doux. Pour un
nettoyage plus en profondeur; utilisez
de I'alcool isopropylique. N'utilisez pas
de solvant, comme I'alcool éthylique,
['éthanol, I'acétone, I'hexane, etc.

Rép.:

Q8:

Comment modifier le réglage des
couleurs sur mon moniteur ?

Rép.:  Vous pouvez modifier le réglage des
couleurs depuis la commande du menu

a I'écran. Suivez la procédure ci-dessous,
*  Appuyez sur « OK » pour afficher le menu
OSD (affichage a I'écran).

*  Appuyez sur la « Down Arrow » (Fleche
vers le bas) pour sélectionner |'option



«Color» (Couleur). Appuyez ensuite sur «
OK'» pour ouvrir le sous-menu de réglage
des couleurs ; il y a trois réglages indiqués
ci-dessous.
1. ColorTemperature (Température
de couleurs) : Les six réglages sont 5
000K, 6 500K, 7 500K, 8 200K, 9 300K
et 11 500K. Avec un réglage dans de

température de 5 000K I'écran apparaft

« chaud », avec une tonalité rouge-

blanc, alors que la température 11 500K

est plus « froide », avec une tonalité
bleu-blanc.

2. sRGB:il s'agit d'un réglage standard
permettant d'assurer le bon échange
des couleurs entre différents appareils
(par exemple les appareils photos
numériques, les moniteurs, les
imprimantes, les scanners, etc.)

3. User Define (Défini par I'utilisateur):
I'utilisateur peut choisir son réglage
préféré des couleurs en ajustant le
rouge, le vert et le bleu.
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Une mesure de la couleur de la lumiére

émise par un objet lorsqu'il est chauffé. Cette
mesure s'exprime en termes d'échelle absolue
(degrés Kelvin). Les températures Kelvin faibles,
comme 2 004K, sont rouges. Les températures
plus élevées, comme 9 300K sont bleues. La
température neutre est blanche, a 6 504K.

Q9:  Est-il possible de connecter mon
moniteur LCD a n'importe quel PC,

station de travail ou Mac ?

Rép.:  Qui.Tous les moniteurs LCD Philips
sont compatibles avec les PC, les Mac
et les stations de travail standard.Vous
aurez peut-étre besoin d'un adaptateur
de cable pour brancher le moniteur
sur un systeme Mac. Nous vous
recommandons de contacter votre
représentant commercial Philips pour

plus d'informations.

Q10: Les moniteurs LCD Philips disposent-

ils de la fonctionnalité «Plug-and-Play»?
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Rép.:  Oui, les moniteurs sont compatibles
'Plug-and-Play" avec Windows
7, Windows 8 Vista, XB NT, Mac OSX

et Linux.

Q11:  Qu'appelle-t-on « image rémanente »,
« image en surimpression », « image
résiduelle », ou « image fantéme »

pour les écrans LCD?

Rép.: L'affichage sans interruption d'image
statique ou immobile sur une longue
période peut engendrer une «
rémanence a I'extinction », également
appelée « image résiduelle » ou « image
fantdme » sur votre écran. Ces images
« rémanentes », « en surimpression »
ou « fantdmes » sont un phénomene
bien connu de la technologie des
panneaux LCD. Dans la plupart des cas,
cette « rémanence a |'extinction », ou «
image résiduelle » ou « image fantdbme
» disparait progressivement une fois
I'alimentation éteinte.

Activez systématiquement un
programme économiseur d'écran en
mouvement lorsque votre écran n'est
pas sollicité.

Activez systématiquement une
application de rafraichissement
périodique de votre moniteur LCD
pour afficher un contenu statique fixe.

) Avertissement

Les symptomes de « brllure », d'« image
résiduelle » ou d'« image fantéme » ne
disparaitront pas et ne pourront pas étre
réparés si vous n'utilisez pas un économiseur
d'écran ou une application de rafraichissement
périodique de I'écran. Ce dommage n'est pas
couvert par votre garantie.

Q12:  Pourquoi mon Affichage ne me permet
pas d'obtenir un texte clair, le contour
des caractéres affichés n'est pas net ?

Rép.:  Votre moniteur LCD fonctionne de

fagon optimale en utilisant la résolution
1600%900 a 60Hz. Pour un affichage
optimal, utilisez cette résolution.
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